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What's New in Mac OS 8.1 Update

 

Mac OS Extended Format

 

Mac OS 8.1 now supports a new volume format called Mac OS 
Extended format. The hard disk format supported by Mac OS 
version 8.0 and earlier is Mac OS Standard format. Mac OS 
Extended format optimizes the storage capacity of large hard 
disks by decreasing the minimum size of a single file. As an 
example, on a 4 GB hard drive a file containing only 4K of 
information requires 64K of space in Mac OS Standard 
format, whereas with the Mac OS Extended format, it will 
require the actual 4K on the 4 GB hard disk.

Existing hard disks formatted with Mac OS Standard format 
will continue to function and be supported by Mac OS 8.1. To 
determine whether a disk was initialized with Mac OS 
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Standard format or Mac OS Extended format, select the disk, 
and choose "Get Info" from the File menu.

If you want to use Mac OS Extended format on one or more of 
your hard disks, please refer to “About Mac OS 8.1 Extended 
Format” later in this document. For additional help in 
creating and using a Mac OS Extended format volume as a 
start up volume, please go to: <http://www.apple.com/
support>.

 

Universal Disk Format 1.0 (UDF)

 

 UDF is a new industry standard file format. The version of 
UDF in Mac OS 8.1 supports UDF formatted CD ROM discs and 
UDF formatted DVD ROM discs. In order to use a UDF 
formatted DVD ROM disc, your computer must have a DVD 
ROM drive and the appropriate driver. UDF requires a 2x or 
faster CD ROM or DVD ROM drive.
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LaserWriter 8.5.1

 

LaserWriter 8.5.1 adds support for IP printing, Custom 
Page Size, PostScript 3 printers, Acrobat PDF files in the 
Save As File option. It also improves support for ColorSync 
and adds support for Desktop Printer Utility.

 

PC Exchange 2.2

 

PC Exchange supports VFAT and FAT32 volume formats as 
used by Windows 95. Support for Long File Names (LFN), 
DOS (FAT) file system and FAT32 support for 4 GB Volumes 
has also been added. PC Exchange now has better support for 
removable media, such as Jaz, Zip, and PMO.

Problems with Pinnacle Magnetic Optical DOS formatted 
drives, Maxtor SCSI hard drives, PC formatted Quantum 
160MB hard drives and SCSI DOS drives greater than 1 GB 
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have been addressed. Plus:

PC Exchange will now mount drives over 1 GB.

Get Info now shows the correct number of items on a DOS 
disk.

PC Exchange now works with shared folders.

 

Open Transport 1.3

 

Open Transport 1.3 provides improved performance and 
single-link multihoming support. Complete details are 
provided in OT 1.3 information.

 

Finder

 

Now has improved performance when copying to and from 
shared volumes.
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Sound

 

Previously, audio management was determined by your 
computer, now your applications control audio input and 
output setups. There is a new control strip module which 
allows easier user selection of sound input source.

Mute selection in the Monitors & Sound control panel retains 
its settings with volume changes.

 

Mac OS 8.1 CD Additions

 

Location Manager 2.0.1

 

Now works on all Mac OS computers.
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QuickDraw 3D 1.5.3

 

Fixed incompatibilities with some high-end 3D rendering 
applications.

 

Mac OS Runtime for Java 2.0

 

This is Apple's implementation of Sun's JDK 1.1.3 
specification. More information provided in the Mac OS 
Runtime for Java 2.0 documentation.

 

Internet Explorer

 

Microsoft Internet Explorer is now the default Browser for 
clean install or new computers. Internet Explorer uses 
Apple's MRJ as its Java engine.

If you use Internet Setup Assistant to register with an ISP, 
the Netscape Navigator Browser will be used.
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Find File

 

Find File has been added to the Apple Menu when the Mac OS 
8.1 CD is used to startup your computer so that you can find 
a file easily. The copy feature of the Find File (or dragging a 
file from the Items Found window) does not work because the 
startup volume is locked. If you need to copy a file that you 
found, open its enclosing folder by double-clicking on it in 
the lower part of the Items Found window.
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Known Issues with Mac OS 8.1

 

Installation

 

When doing a custom install from the Mac OS 8.0 CD or Mac 
OS 8.1 CD, if a component is selected which is newer in Mac 
OS 8.1, a dialog will be presented which states that a newer 
version already exists. This will give you the option of 
selecting the older or newer version. Select the newer 
version because the older version may not be compatible 
with Mac OS 8.1.

 

Important:

 

 When using the Mac OS 8.1 CD, the installer first 
runs the Mac OS 8 installation and then automatically runs 
the Mac OS 8.1 Update, LaserWriter 8.5.1, and Open 
Transport installations. This occurs when you are doing 
either an Easy Install, a Custom Install, or Custom Remove.
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Acrobat 3.0

 

Because of installation order requirements, please refer to 
the About Adobe Software document.

 

Netscape Navigator 4.04

 

If you do not already have an ISP (Internet Service 
Provider) and plan on using the Internet Setup Assistant to 
obtain one, register for one before upgrading to Netscape 
Navigator 4.04 which has been provided on the Mac OS 8.1 
CD in addition to Netscape Navigator 3.01. Existing accounts 
will work without any problems, but you may not be able to 
create any new ISP accounts once you have upgraded to 
Netscape Navigator 4.04.
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Display Name Change

 

AppleVision 750 and 850 displays were recently renamed 
ColorSync Displays. Mac OS 8.1 delivers a new Monitors & 
Sound Control panel which will identify these monitors as 
ColorSync Displays. You can continue to use the AppleVision 
750 or 850 ColorSync profiles as they are identical to the 
renamed versions.

 

DVD disc will not mount after bootable CD

 

If you have a DVD ROM drive connected to your computer and 
start up the computer with a bootable CD ROM disc in the 
drive, but not as the boot volume, you may not be able to use 
DVD discs until you remove the CD ROM disc and restart the 
computer. To use the DVD ROM drive make sure you do not 
have a bootable CD ROM disc in the drive when starting the 
computer unless you are booting from it. After starting the 
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computer, you may then use both CD ROM and DVD discs.

 

Password Security and booting from Mac OS 
Extended

 

When using a Mac OS Extended formatted drive as your start 
up disk, the Password Security control panel will not 
function properly. Do not use the Password Security control 
panel if you plan to password protect and then start up from 
a Mac OS Extended formatted volume.

Do not try to reformat a disk drive which currently is 
password protected.

 

LocalTalk PCI

 

Mac OS 8.1 installs a new extension on some models called 
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LocalTalkPCI which is a PowerPC version of the LocalTalk 
driver. This new driver provides improved performance 
when using LocalTalk. However, this improved performance 
can cause some LocalTalk printers to be invisible when 
using the Chooser to select a printer. If you encounter this  
problem use the Extensions Manager to disable LocalTalkPCI 
and the printer will become visible and selectable.

 

Sound

 

The following items do not effect Macintosh 68K and Power 
Macintosh 6100/7100/8100 series computers, nor Mac 
OS compatibles based upon the Power Macintosh 6100/
7100/8100 series. 

– With Mac OS 8.1, the Sound control panel found in the 
Apple Extras folder can no longer be used to set the 
sound input source. Use the Monitors & Sound control 
panel or a new control strip module to change the input 



 

 Mac OS 8 Update   Known Issues with Mac OS 8.1 - 14

 

source.
– Changing the volume in the Sound control strip module 

will not unmute the computer. If you have selected the 
mute check box in the Monitors & Sound control panel, 
you must use Monitors & Sound to unmute the computer.

– When using the PC Compatibility software with a DOS 
compatible system, you may need to manually select the 
sound input source after inserting an audio CD. The PC 
Compatibility software plays sounds through the CD 
input source, so you must select CD input in the 
Monitors & Sound control panel or the SoundSource 
control strip module to hear sounds from the PC Card.

– When using Apple Speech Recognition version 1.4.1 
software on some computers, an error will be reported 
that your microphone is not standard or is not 
connected. This error is reported when turning on the 
Speakable Items feature. To avoid the error, select 
"none" as the sound monitor source before turning on 
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this feature, then change the monitor source to 
"Microphone". This error may be ignored, and the 
Speech Recognition software can be used normally. This 
will occur on PCI-based computers and some PowerPC-
based PowerBook computers.

 

Printing

 

• Use QuickDraw GX 1.1.6 or later with Mac OS 8.1.
• Desktop Printer Utility
• Desktop printers created with the Desktop Printer 

Utility will not appear configured in the Chooser, but the 
printer will still operate normally.

To create a printer in a different AppleTalk zone, do not use 
the Desktop Printer Utility found in the Apple Extras folder. 
Use the Chooser from the Apple Menu to create the printer.
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Apple Language Kits and Mac OS 8

 

Apple's language kits require an updater for full 
functionality with this version of the Mac OS. The Language 
Kit Updater for Mac OS 8 can be downloaded from the 
software updates area of Apple's Web site, America Online, 
and other sites where Apple software updates are available.

After an Apple language kit is installed on a Mac OS 8.1 
system you must also install the Language Kit Updater for 
Mac OS 8. Following that, you must open the Language Kit 
Additions folder within the Extensions folder and remove all 
LaserWriter and PrintLib files which have a version earlier 
than 8.5. Not removing these files can cause the application 
to unexpectedly quit when you attempt to print.

Apple does not recommend installing system software by 
making a copy of an existing system folder because 
important files used when starting up may not be found and 
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the system software will have to be reinstalled.

 

Mac OS Extended and Language Kits

 

The Disk Tools PPC that is supplied with Mac OS 8.1 is 
intended for use with the primary script and English. If you 
are using a Language Kit (secondary script) you must use 
the Mac OS 8.1 CD. If you use a Disk Tools PPC floppy which 
you have created to startup the computer, file and volume 
names that were created with the secondary script will 
appear scrambled or missing. If you attempt to change any of 
them, the files may become lost.
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Miscellaneous

 

G3 PowerBooks and PowerBook 3400

 

AppleTalk zones are unavailable when booting from the Mac 
OS 8.1 CD on G3 PowerBooks and PowerBook 3400.

 

ARA 3.0

 

If you are going to install ARA 3.0, do not select the Apple 
Remote Access optional install when installing Mac OS 8.1. 
Do not install ARA 2.1 over 3.0.

When using ARA 3.0 do not use Internet Dialer as the 
connection application, instead use the Remote Access to 
connect.
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Video Cards

 

While starting up on some computers, the screen may flash, 
go black and reappear. This is normal and occurs when a 
ROM video driver is replaced by a newer driver in the 
system folder. It occurs with some Apple and third party 
video cards.

 

Apple Video Player MPEG movies

 

If Apple Video Player cannot find an MPEG movie due to the 
movie's title, use MoviePlayer's import command.

 

Apple Video Player

 

There is a problem recording video in Apple Video Player 
when the 'no compression' option is selected and Virtual 
Memory is turned off. When you stop recording, the 
computer may appear to hang for two to four minutes and the 
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following error message "An error occurred while trying to 
record" appears and you will not be able to save the 
recording. To avoid this problem turn Virtual Memory on or 
select a different compression option.

 

Compatibility Issues with Third Parties

 

Mac OS 8.1 and Mac OS Extended format issues

 

There are several types of programs that may be 
incompatible with Mac OS 8.1 and the new Extended format:

– Utilities that check the integrity of a disk volume
– Programs that provide password security for volumes
– Audio and video programs that write data directly to the 

volume.

Please contact the vendor of the program for revised 
versions.
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Norton Utilities

 

Norton Utilities 3.5.3 is compatible with Mac OS Standard 
volumes, but Mac OS Extended volumes are treated as remote 
volumes and cannot be accessed.

If you are using the Norton Utilities for Macintosh 3.5.1 or 
earlier, do not run the following Norton Utilities on a Mac OS 
Extended volume: Disk Doctor, Speed Disk, Wipe Info, 
FileSaver, UnErase, Volume Recover, and Disk Editor. Later 
versions of the Norton Utilities for Macintosh will support 
the Mac OS Extended format and will be available on the 
Symantec web site: <www.symantec.com>.

 

Conflict Catcher

 

Conflict Catcher is not compatible with the Mac OS 8.1. 
Casady and Greene has requested Apple disable the program 
due to the severity of this incompatibility. If the files are 
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found, an error message will indicate the Conflict Catcher 
extension is located in the Mac OS Extension folder and must 
be disabled before installing Mac OS 8.1. Please contact 
Casady and Greene for version 4.1 which is compatible with 
Mac OS 8.1 by calling (408)484-9228 or visiting their 
Web site at <www.casadyg.com>.

 

PGPdisk 1.0

 

Functions correctly on Mac OS 8.1 provided the PGPdisk 
volume file is located on a Mac OS Standard volume. If it is 
located on a Mac OS Extended volume, you will get an error 
after the passphrase is entered for that volume, and it will 
not appear on the desktop. All data remains intact. To access 
the volume, you need to either obtain PGPdisk 1.0.1 or move 
the volume file to a Mac OS Extended volume. Contact PGP at 
<http://www.pgp.com> for information regarding updates.
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PC Cards

 

Because of changes in Mac OS 8.1 some third-party PC Card 
drives will no longer function. Some updated drivers have 
been provided in the CD Extras folder. Please contact the PC 
Card vendor for other drivers as needed.

 

Quarterdeck Mail (also known as Microsoft Mail for 
Networks)

 

Client applications, versions 4.1 and earlier, are not 
compatible with Mac OS 8.1. For information on upgrading 
to version 4.2, please contact StarNine/Quarterdeck at 
info@starnine.com or <www.starnine.com>.

 

AdobePS 8.5.1

 

If your printer comes with the AdobePS 8.5.1 installer and 
you wish to continue using other LaserWriter printers 
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follow the steps outlined here.

Before installing AdobePS 8.5.1, find and move the 
PrintingLib extension from the Extensions folder to your 
desktop. Install AdobePS 8.5.1. Drag the PrintingLib 
extension from your desktop back into the Extensions folder. 
A dialog will warn you that a file with that name already 
exists: click OK to replace it with the one from your desktop. 
The version of PrintingLib that is available with Mac OS 8.1 
includes all of the functionality of AdobePS 8.5.1.

If you have already installed AdobePS 8.5.1, find and move 
the PrintingLib extension to the Trash. Then install Mac OS 
8.1.

 

Mac OS 8.0 Issues not fixed with Mac OS 8.1

 

• PowerBook 1400 computers and Apple Video Player. 
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There is no support in Apple Video Player for the 
PowerBook 1400 series computer. Open the 
MoviePlayer application found in Apple Extras folder to 
view MPEG files using QuickTime MPEG software.

• PowerBook 190, 190c, and 5300c computers. On 
PowerBook 190, 190c or 5300c computers the display 
may appear blank when you first restart after installing 
Mac OS 8, or after resetting PRAM. This is because the 
power manager is being updated on the PowerBook. 
Restarting the PowerBook one more time will result in a 
normal screen. To shut down the PowerBook safely, 
press the Power button one time (which brings up the 
shutdown dialog box) then press the Return key.

• MBDF virus and Mac OS 8. If you notice that the menubar 
becomes white and disables the menubar clock, your 
computer may be infected with the MBDF virus. With 
previous versions of the Mac OS, you may not have 
noticed that your computer was infected with this virus. 
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Use a virus detection application to identify and remove 
MBDF and other viruses from your computer.

 

Note:

 

 Please refer to the Mac OS 8 Read Me for other 
known issues.

 

Mac OS 8.1 TIL Articles

 

Mac OS 8.1: FM Radio Error After Installation (22141)

 

I just installed the Mac OS 8.1 update. When I try to open 
the Apple FM Radio application, I keep getting the 
message "The FM Radio Component in the Extensions 
folder is not the correct version." What could be causing 
this message?

 

Mac OS 8.1: Where Have All My Files Gone? (24319)

 

If you have used Mac OS 8.1 to format your hard drive as 
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a Mac OS Extended Format (HFS+) volume, a single text 
file containing the following information is the only file 
that will appear on your hard drive.

 

Mac OS 8.1: Aliases Cannot Find Originals (30350)

 

I updated my System Folder from Mac OS 8.0 to 8.1, 
backed up my entire hard drive, reformatted it as Mac 
OS Extended format, and restored all my files from 
backup. Now, none of my existing aliases work, and any 
new aliases I create cannot find the originals either. 
What's wrong?

 

Mac OS 8.1: Using non-Apple CD-ROM Drives(30346)

 

Power Computing customers and Mac OS-Compatible 
computer customers may need to create special Disk Tool 
disks for using with Mac OS 8.1. This process will be the 
same as previously with Mac OS 8.0.
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Mac OS 8.1: Certain Mac OS 8.1 Extensions Appear 
Corrupted or Damaged (22142)

 

Mac OS 8.1 installs various system extension files which 
may appear corrupt or damaged when inspected by 
certain third-party utility software.
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How to Install Mac OS 8.1

 

This section describes how to install Mac OS 8.1. It includes 
compatibility information, instructions for installing Mac 
OS 8.1, and basic installation troubleshooting.

Updating your system using the downloaded Mac OS 8.1 
Update image requires that you already have Mac OS 8.0 
installed. If you are using the Mac OS 8.1 Reference CD, you 
may install onto Mac OS system versions 7.5 through 8.1.

For more information, see the Mac OS 8 installation manual. 

 

WARNING:

 

  PowerTalk is not compatible with Mac OS 8.1. 
After you install any version of Mac OS 8, you will not be 
able to access your PowerTalk mail or catalogs, nor will you 
be able to use your keychain or other PowerTalk services. 
See the Mac OS 8 installation manual for more information. 
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WARNING:

 

  Application programs that use QuickDraw GX 
may not be able to print due to changes in the version of 
QuickDraw GX included with Mac OS 8. See the file About 
QuickDraw GX for more information. 

 

Before You Install

 

Important:

 

 In order to install Mac OS 8.1 on PowerPC 
machines with less than 16 MB of RAM, it will be necessary 
to reboot with extensions off (by holding the shift key until 
you see the Welcome to Mac OS message).

 

Important:

 

 If Apple Remote Access 3.0 (ARA 3.0) Personal 
Server is installed, make sure answering is off before 
upgrading to System 8.1. To ensure answering is off in ARA 
3.0, make sure the answering option is unchecked in the ARA 
Answering dialog. To get to the dialog, open the Remote 
Access control panel and select Answering... from the Remote 
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Access menu. After the 8.1 update installation has 
successfully completed, turn answering back on from the 
same dialog.

 

Note:

 

 If you want to create and use a Mac OS Extended format 
volume, make sure that you read the file “About Mac OS 
Extended format.”

 

Before You Install Steps

 

1 Turn off any security software that you may have 
installed on your computer.

2 Turn off any virus-protection software that you may 
have installed on your computer.

3 If you have a PowerBook, make sure that it is plugged 
into AC power and set not to go to sleep.

4 If you have AppleShare software earlier than version 
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3.6.4, you should upgrade to version 3.6.4 before 
installing Mac OS 8 over a network. See the document in 
the AppleShare folder in the Utilities folder for 
instructions.

5 When doing a clean install, write down your current 
Internet settings, such as the IP address, subnet mask, 
name server, and so on. After installation, the Internet 
Setup Assistant will ask you to enter this information.

 

Important:

 

 Apple recommends that you make a Disk Tools 
floppy disk; if you have downloaded the Mac OS 8.1 Update 
from the Apple Internet website, make sure that you also 
download the Disk Tools for PPC disk image. For all Mac OS 
compatible computers with a 68040 processor, except the 
PowerBook 190, use the "Disk Tools 1" disk. If you have a 
Mac OS 8.1 CD-ROM disc, you will find this disk image in 
the Disk Tools Images folder.
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To make a Disk Tools floppy disk :
• Run the Disk Copy program
• From the "Utilities" menu select "Make a Floppy ..."
• Find the disk image "Disk Tools for PPC" and select it
• Press the Open button
• When requested insert a 1.4 MB high density floppy 

disk
• When asked if you are sure that you want to erase the 

floppy, press the "Yes" button
• After the floppy disk is finished copying, remove it 

from the drive
• Select "Quit" from the "File" menu

 

Disk Space Requirements

 

The amount of disk space required to do a full install of Mac 
OS 8.1 will vary greatly dependent on several factors as 
outlined below.
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• The First is the size of the hard disk volume being used.

For Mac OS Standard format volumes, the larger the 
volume the more space that will be required. This is 
because the minimum file size supported on a Mac OS 
Standard format volume increases as the size of the 
volume increases.

For Mac OS Extended format volumes, the amount of 
space needed is the same regardless of volume size 
because the minimum file size is a constant.

• The Second size factor is the number of optional software 
packages that you choose to install. Apple has preselected 
some optional software packages, but you have the option 
of selecting others or deselecting the preselected 
packages.

• The Third size factor depends on what method was used to 
start the computer. If the computer was started up from 
the volume that is being updated or from the Mac OS 8.1 
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CD, Disk Tools Floppy or another volume, such as an 
external Hard Disk more space will be required. When 
the computer is started up from the volume that is being 
updated, the installer must create temporary files that 
are used until the computer is restarted.

• The Fourth size factor is the type of computer that you 
have. Each model has a slightly different set of Mac OS 
system components required to be installed to function 
correctly.

• The Final size factor depends on the volume onto which 
you are performing the install: whether or not the 
volume already has Mac OS system files and if the "clean 
install" option was selected.

Below are tables which suggest requirements for easier 
installation, as well as space used after installation process 
is complete.
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Table 1

 

—An Install of just the base Mac OS system software 
with all of the optional items deselected:

Volume 
Size

Format 
Install

Needed 
for Restart

Used
After

2 GB Standard 135 MB 68 MB

1 GB Standard 120 MB 58 MB

500 MB Standard 115 MB 50 MB

Any size Extended 118 MB 56 MB
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Table 2

 

—An Install of the base Mac OS system software and 
the Apple preselected optional software using the Mac OS 8.1 
CD to start up the computer:

Volume 
Size

Format 
Install

Needed 
for Restart

Used
After

2 GB Standard 152 MB 140 MB

1 GB Standard 139 MB 129 MB

500 MB Standard 127 MB 117 MB

Any size Extended 132 MB 122 MB
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Table 3

 

—An Install of the base Mac OS system software and 
the Apple preselected optional software onto the volume that 
was used to start up the computer: (

 

Note:

 

 This is not a 
recommended method.)

When doing a "clean install" the space required is in addition 
to the amount used by the current System folder.

Volume 
Size

Format 
Install

Needed 
for Restart

Used
After

2 GB Standard 190 MB 140 MB

1 GB Standard 176 MB 129 MB

500 MB Standard 162 MB 117 MB

Any size Extended 172 MB 122 MB
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Installation Procedure

 

1 Start up your computer using the Mac OS CD-ROM disc 
or an appropriate Disk Tools floppy disk. See your 
installation manual for instructions.

2 If you can't start up with the Mac OS 8.1 CD or Disk 
Tools floppy disk, be sure to do the following additional 
step: Disable all non-Apple extensions and control 
panels. If you have System 7.5 or later, use the 
Extensions Manager control panel to select the System 
7.x or Mac OS 8 base set of extensions and control panels. 
See the installation manual for more details.

3 Restart your computer before installing Mac OS 8.1.

4 Although compatibility problems are not expected, you 
can ensure a smooth upgrade by checking with the 
manufacturers of any non-Apple software you use to 
make sure it is compatible with Mac OS 8.1. If you do 
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experience a problem, see the troubleshooting chapter 
in your installation manual for more information on 
isolating compatibility problems.

5 When reinstalling Mac OS 8.1 onto a volume which 
already contains a Mac OS 8.1 system file, after 
selecting the volume a dialog will appear asking if you 
want to reinstall or if you want to perform a custom 
install/remove. If you select the reinstall option, the 
Mac OS 8.0 installation program will display a series of 
dialogs stating that newer versions of some components 
are already present. In order to perform a reinstall, you 
must press continue for each of these dialogs. After the 
Mac OS 8.1 installation program finishes, the Mac OS 
8.1 updater will reinstall the previously mentioned 
components.
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Compatibility Information

Computers With 68040 Processor Upgrade Cards

Computers upgraded to 68040 with a processor upgrade 
card are not supported by Mac OS 8. 

Performa or Power Macintosh 5000 and 6000 Series 
Computers

Performa or Power Macintosh 5000 and 6000 series 
computers Some Performa or Power Macintosh 5200 
series, 5300 series, 6200 series, and 6300 series models 
cannot use Mac OS 8.1 until a hardware problem is fixed. 
The repairs are covered under the Apple repair extension 
program. To see if your computer has this hardware 
problem, use the 5xxx/6xxx Tester utility in the Utilities 
folder on the CD before installing Mac OS 8.1. 
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Important:  The Power Macintosh or Performa 6320, 6360, 
and 5260 do not have this hardware problem. If you have a 
Power Macintosh or Performa 6320, 6360, or 5260, you 
do not need to use the tester program. 

Installing Mac OS 8.1 on Accelerated NuBus PowerPC 
Computers

If you have a Power Macintosh 6100, 7100, 8100, or 
9150 with a third-party accelerator that increases the 
clock speed of your computer, the Installer might refuse to 
install Mac OS 8.1 because it doesn't recognize your system. 
You may need to remove the third-party accelerator before 
installing Mac OS 8.1.

MacODBC and Mac OS 8.1

If you use MacODBC, you should either install it before 
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installing Mac OS 8.1, or perform a custom install of 
MacODBC and make sure the ASLM extensions are not 
selected. The MacODBC installer installs older versions of 
ASLM extensions that are incompatible with Mac OS 8.

Third-Party Finder and Utility Software

Some third-party programs that extend or add features to 
Mac OS may be incompatible. Examples include programs 
that change the way menus work, change how files are 
stored, or alter the way you work with files in the Finder. 
Contact the software's manufacturer for information about 
using such programs with Mac OS 8.1. This is especially 
important if you're using a program that automatically 
alters the way files are stored (such as compressing them) 
because you might not be able to access those files until you 
obtain updated software for use with Mac OS 8.1.
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400K Diskettes and Mac OS 8

The 400K MFS diskette format is not supported by Mac OS 
8.1. If you have information or programs on obsolete 400K 
diskettes that you want to access, copy the files to your hard 
disk, an 800K diskette, or a 1.44 MB diskette before 
installing Mac OS 8.1.

Using the Install Mac OS 8.1 Program

To ensure a successful upgrade, use the Install Mac OS 8.1 or 
the Update to Mac OS 8.1 program to install the software. 
This program performs all the tasks recommended for a 
successful installation and simplifies the installation 
process. Refer to the Mac OS 8 installation manual and the 
onscreen help in the program for more information.

If you select the information button for a component in the 
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installer, while doing a custom install, the installer may 
report an earlier version number than the component that is 
actually installed. For example, the information button for 
Apple Video Player will report the version to be installed as 
1.6.2. This is incorrect. Version 1.7.1 of Apple Video Player 
will actually be installed.

Troubleshooting Suggestions

Some Apple-branded disks manufactured by third parties, 
including the Apple 365 MB external hard disk, are not 
supported by the Apple disk utilities. If your disk cannot be 
updated with the Apple utilities, you will need to use a 
third-party disk utility to update the driver.

If you see a message that your disk has problems and cannot 
be repaired, turn off file sharing if it is on, then try 
installing again. If that does not work, try using another 
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disk-repair utility. If you do not have another utility, or if 
that utility also does not work, you may need to reinitialize 
the disk. Copy all your files to another disk first, as 
reinitializing erases the disk. For more information about 
reinitializing, see the manual that came with your 
computer.

If you experience problems during installation, be sure to 
start up with the Mac OS 8.1 CD-ROM disc or the Mac OS 8.1 
Disk Tools floppy disk. See your installation manual for 
instructions.

If you are installing over a network, or if you have a non-
Apple CD-ROM drive and can not start up with the CD or 
disk, turn off all extensions that were not provided with 
your system software. Then restart the computer.

See the troubleshooting chapter in your installation manual 
for additional suggestions.
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Late Breaking Tips

Password Security

Mac OS 8.1 will not install the new Password Security 
control panel on a PowerBook 2400 or 3400 unless it 
already exists in the Control Panels folder. To get a working 
version of the Password Security control panel, you can 
custom install it from the Mac OS 7.6.1 CD and then install 
Mac OS 8.1. Alternatively, the new control panel (version 
1.0.6) is available at Apple Software Updates in the 
PowerBook section.

Note: Mac OS 8.1 installs version 1.0.6 of the Password 
Security control panel and this version is required to work 
correctly with Mac OS 8.0 or Mac OS 8.1.
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If You Need To Make AppleTalk Inactive

The default networking option for the Macintosh is to use the 
printer port for AppleTalk. In order to use the printer port 
for a serial device it is necessary to stop using the printer 
port for AppleTalk. There are two ways to accomplish this.

 The first is to move AppleTalk to another port such as 
Ethernet (if you are connected to an Ethernet network). The 
second method is to make AppleTalk inactive.

During the migration from Classic Networking to Open 
Transport, older components of the networking software 
have not been upgraded to fully support Open Transport. Two 
such components are the Chooser and the AppleTalk Switch 
Control Strip Module. If AppleTalk is made inactive using 
either the Chooser or the Control Strip then only Classic 
AppleTalk components are made inactive. Open Transport 
AppleTalk components are still active. When you attempt to 
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use the printer port for a serial device the following error 
messages (or similar messages) may result.

• "Printer port is in use by another application"
•  "Cannot find printer"
•  ".[XXX printer driver] requires that AppleTalk is 

inactive. Please make AppleTalk inactive."

The recommended method of making AppleTalk inactive 
under Open Transport is to:

1 Open the AppleTalk control panel.

2 Select User Mode under the Edit menu (or Command-U).

3 Select Advanced user mode and click OK.

4 Click on the Options button.

5 Select Inactive and click OK.

6 Close the AppleTalk control panel.
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7 Save the changes.

Location Manager 2.0.1 offers a convenient way to turn  
AppleTalk on and off. For more information, please see the 
Read Me included with Location Manager 2.0.1.

PlainTalk Text To Speech Info

PlainTalk Text To Speech, when used with a GeoPort, may 
cause a crash when used with Mac OS 8.1. Apple is aware of 
this problem and expects to have a solution with the next 
Mac OS release.

Creating a Mac OS Extended volume for use as a 
startup volume

For steps on how to do this, please consult the Tech Info 



 Mac OS 8 Update Late Breaking Tips - 51

Library article: Mac OS 8.1: Creating a Mac OS Extended 
Startup Volume - /techinfo.nsf/artnum/n30339. The text 
of this TIL article is included in this document.

Note: Apple recommends that you do not use a Mac OS 
Extended formatted volume as your startup disk unless you 
have the Mac OS 8.1 CD.
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About Mac OS 8.1 Extended Format
This section discusses the new volume format called the Mac 
OS Extended format.

Important:  Apple recommends that you do not use a Mac OS 
Extended formatted volume as your startup disk unless you 
have the Mac OS 8.1 CD.

Mac OS 8.1 Volume Formats

Mac OS 8.1 now supports a new volume format called the 
Mac OS Extended format. The hard disk format supported by 
Mac OS 8.0 and earlier is now referred to as the Mac OS 
Standard format. Mac OS Extended format optimizes the 
storage capacity of large hard disks by decreasing the 
minimum size of a single file. As an example, on a 4 GB hard 
drive a file containing only 4K of information requires 64K 
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of space in Mac OS Standard format, whereas with the Mac OS 
Extended format, it will require the actual 4K on the 4 GB 
hard disk.

Always Backup Your Hard Disk Before Initializing

Whenever you initialize your hard disk, you must first back 
up your files. Initializing will erase all the data on the hard 
disk.

Mac OS Extended format is Supported by Mac OS 8.1 
and Later

All computers must have Mac OS 8.1 or later installed to 
access the files on a Mac OS Extended format volume that is 
directly connected to the computer. If a Mac OS Extended 
format volume is connected to a computer running Mac OS 8 
or earlier, you will not see any of the files on the hard disk. 
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You will see a document explaining that your files are still 
on the hard disk, but unaccessible. You will be able to access 
those files once you connect that hard disk to a computer 
running Mac OS 8.1 or later. However, Mac OS Extended 
formatted volumes shared on a network by a computer 
running Mac OS 8.1 or later can be seen by a computer 
running Mac OS 8 or earlier.

When to Choose Mac OS Standard instead of Mac OS 
Extended format

Volumes smaller than 32 MB can not be initialized as Mac OS 
Extended format; if you attempt this using the Drive Setup 
application it will state the "Initialization Failed." Floppy 
disks can not be initialized with Mac OS Extended format.

The storage efficiency of Mac OS Extended format typically 
applies to 1 GB or larger volumes.
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How to Initialize with Mac OS Extended format

After backing up your data, you must initialize your hard 
disk to change the format from Mac OS Standard format to 
Mac OS Extended format. Always backup your hard disk 
before initializing. Initializing erases all the data on the 
hard disk. Once you have backed up your data, you can choose 
to use either of the following options to initialize the hard 
disk:

Option 1: In the Finder, select the hard disk you wish to 
initialize. Choose Erase Disk... from the Special menu. A 
dialog will be displayed which contains a pop-up menu 
where you can select Mac OS Extended format.

Option 2: Open the Drive Setup application, version 1.4 or 
later. Choose Initialize. A dialog will be displayed where you 
can specify Mac OS Extended format, as well as other 
initialization options.
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Note: You must select the number of volumes in the 
Partitioning Scheme pop-up menu before selecting a volume 
format. Drive Setup can partition a disk into multiple 
volumes and each may have a different format.

After initializing, you may restore the data from your 
backup. After restoring, double-clicking on some aliases 
may result in the error "the original item could not be 
found". Locate the original file, and recreate the alias.

680x0 Specific Issues

680x0 processor computers can not use a hard disk 
initialized with Mac OS Extended format as the start up disk, 
but the Mac OS Extended format can be used on additional 
disks connected to a 680x0 computer running Mac OS 8.1 or 
later. In addition, you can not select a hard disk initialized 
with Mac OS Extended format in the Virtual Memory section 
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of the Memory control panel.

Text Encoding Converter Extension and Text Encoding 
Folder

Warning: Proper installation of Mac OS 8.1 will 
automatically place the Text Encoding Converter extension 
and the Text Encoding folder in the System Folder. In order 
for Mac OS Extended format to function properly, you must 
not move or delete these files.

Frequently Asked Questions about the Mac OS 
Extended format

What is Mac OS Extended format?

Mac OS Extended format is a new hard disk format that 
increases the number of allocation blocks on the disk. This 
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new format also allows more than 65,000 files on the hard 
disk. Mac OS Extended format optimizes the storage capacity 
of large hard disks by decreasing the minimum size of a 
single file.

What are the differences between Mac OS Extended 
format and Mac OS Standard format?

The most visible difference between Mac OS Extended format 
and Mac OS Standard format, other than the minimum file 
size, is the maximum number of files.

How do I know a hard disk is Mac OS Extended format?

Select the hard disk in the Finder and choose the Get Info 
command in the File menu. The format information will  
specify either Mac OS Standard or Mac OS Extended.
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Should I reformat my hard disk to be Mac OS Extended 
format?

Mac OS Extended format is most useful for hard drives that 
are 1 GB or larger. Do not reformat a hard disk with Mac OS 
Extended format if it is intended to be used as the startup 
disk for a computer with a 680x0 processor.

Can I use my third party disk utilities with a Mac OS 
Extended format hard disk?

Some third party utilities may not be compatible with hard 
disk initialized with Mac OS Extended format. Consult the 
utility's documentation, or contact the vendor for 
compatibility information.

Can I Format my Server's Hard Disk as Mac OS 
Extended format if my Client Machines Have an Earlier 
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Version of Mac OS?

Yes. The server may use Mac OS 8.1 and Clients may have 
earlier versions of Mac OS. The clients will still be able to 
access all files on the server's Mac OS Extended formatted 
hard disks.

Where can I get more information on Mac OS Extended 
format?

Both Apple Guide and Mac OS Info Center have information on 
the new hard disk format. Choose the Help menu or double-
click on the Mac OS Info Center icon on the desktop to access 
Mac OS Extended information.



 Mac OS 8 Update   Creating a Mac OS Extended Startup Volume - 61

Creating a Mac OS Extended Startup 
Volume
Apple recommends that you do not use a Mac OS Extended 
formatted volume as your startup disk unless you have the 
Mac OS 8.1 CD.

Important: In order to use a hard drive as a Mac OS Extended 
formatted drive, the drive must be erased. In addition, if you 
wish to boot from a drive formatted as Mac OS Extended, you 
will need a PowerPC-based Mac OS computer. You can use a 
Mac OS Extended formatted drive with a non-PowerPC-base 
Mac OS computer, but you will not be able to use it as a 
startup disk or use it as a hard disk for virtual memory.

Below are the steps required to use an Mac OS Extended 
volume as your startup volume on Power PC Mac OS 
compatible computers. There are two ways to get Mac OS 8.1 
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onto a Mac OS Extended Hard Drive.

Method 1

Updating Mac OS 8.0 to Mac OS 8.1 and installing it onto 
a Mac OS Extended volume

1 Update to Mac OS 8.1 or Install Mac OS 8.1. Follow the 
instructions under "How to Install Mac OS 8.1" or refer 
to the Installing Mac OS 8.1 Read Me.

2 Startup from the Mac OS 8.1 Reference CD.
– Place the Mac OS 8.1 Reference CD in the CD drive
– Select "Restart" from the "Special" menu
– Hold the "C" key down on the keyboard until you see the 

"Mac OS" screen
– Verify that you have started up from the CD by looking 

at the desktop. If the pattern looks similar to the image 
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ofnCDs, you are booted from the CD.

3 Make a backup all of the files on your startup disk
– Copy your files to another hard disk
– Copy them to a server on the network
– If you want to use some other method to backup you hard 

drive please referred to the section below entitled 
"Other backup methods"

4 Reformat your volume to be Mac OS Extended. If you want 
to change the partitions on a hard drive refer to the 
Drive Setup Read Me. Otherwise, select "Erase Disk" in 
the Finder to create an Mac OS Extended volume.

– In the Finder, select the volume you want to reformat 
by clicking on it once so that it is highlighted.

– From the "Special" Menu select "Erase Disk..."
– Type in the name you want the reformatted volume to be 

called
– Using the Pop-up menu below the file name, select "Mac 
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OS Extended xxx". The xxx will be the size of the 
formatted volume.

– Click the Erase Button.

     Warning: All of the data on the volume will be lost. You 
will not get a warning telling you that you are about to lose 
all of the data on the volume. Make sure that you have the 
right volume selected. If you erase the wrong volume there 
is no way to recover your data.

5 Restore the files that you backed up in step two.

6 Select "Restart" from the "Special" menu

Method 2

Installing Mac OS 8.1 on an empty drive

Follow these steps only if you have the bootable Mac OS 8.1 
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CD. Otherwise, follow the instructions in "Updating Mac OS 
8.0 to Mac OS 8.1 and installing it onto an Mac OS Extended 
volume.

1 Start up from the Mac OS 8.1 Reference CD
– Place the Mac OS 8.1 Reference CD in the CD drive
– Select "Restart" from the "Special" menu
– Hold the "C" key down on the keyboard until you see the 

"Mac OS" screen
– Verify that you have started up from the CD by looking 

at the desktop. If the pattern looks similar to the image 
of CDs, you are booted from the CD.

2 Reformat your volume to be Mac OS Extended If you want 
to change the partitions on a hard drive refer to the 
Drive Setup Read Me, other wise you can use the Finder's 
Erase Disk function to create an Mac OS Extended volume

– In the Finder, select the volume you want to reformat 
by clicking on it once so that it is highlighted.
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– From the "Special" Menu select "Erase Disk..."
– Type in the name you want the reformatted volume to be 

called
– Using the Pop-up menu below the file name, select "Mac 

OS Extended xxx". The xxx will be the size of the 
formatted volume.

– Click the Erase Button.

     Warning: You will not get a warning telling you that you 
are about to lose all of the data on the volume. All of the data 
on the volume will be lost. Make sure that you have the right 
volume selected. If you erase the wrong volume there is no 
way to recover your data.

3 Install Mac OS 8.1. Follow the instructions in the 
"Installing Mac OS 8.1" Read Me.

4 Restart your computer. Select "Restart" from the 
"Special" menu.
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Other Backup Methods

It is possible to perform other types of backups. However 
you may have to perform extra steps.

Using removable hard drives

In step 2 above, when you start up your computer, the 
removable drive must be inserted in the drive.

Using a recordable CD.

Add the driver for your CD ROM drive to the Disk Tool PPC 
floppy disk as described in "Creating a custom startup 
Floppy" and use the floppy disk to start up your computer.

Using a tape drive

Add the driver for your tape drive to the Disk Tool PPC 
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floppy disk as described in "Creating a custom startup 
Floppy" and use the floppy disk to start up your computer.

Using a backup program to backup the files

Put the backup program on a floppy.

Creating a custom startup Floppy

If you have some special hardware that you need to use 
during the install process you may need to create a custom 
startup floppy. This special hardware could include a non-
Apple CD-ROM Drive, Zip Drive, Jaz Drive, Bernoulli 
removable drive, SyQuest removable drive, tape drive, DAT 
drive, or CD discs other than the Mac OS system discs.

1  Create a startup floppy as described above
2 Remove the programs Drive Setup and Disk First 

Aid
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– Select each file and drag them to the trash
– From the "Special" menu select "Empty Trash"

3 Copy the driver for your hardware from the 
system folder on your hard drive to the system 
folder on the floppy. The drivers are located in the 
"Extensions" folder in the "System Folder". If you 
are going to be using CD-ROMs other than the Mac 
OS CD-ROM, you will need to copy the "Apple CD-
ROM" file to the System Folder on the floppy.

4 Make sure the custom floppy works
– From the "Special" menu select "Restart"
– Put the custom floppy in the floppy drive
– After the system has finished starting up, verify that 

your special hardware functions.

Notes:
• he "Mac OS" screen is in black and white
• If you have two special pieces of hardware (like a 
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non-Apple CD ROM drive and a DAT drive) you may 
have to create two custom startup floppy because of 
the limited space on the floppy, one with each of the 
drivers.
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